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Read Me First
 
Welcome to Take Control of Backing Up Your Mac, version 1.0, 
published in September 2011 by TidBITS Publishing Inc. This book 
was written by Joe Kissell and edited by Michael E. Cohen with help 
from Tonya Engst. 

The data on every Mac should be backed up to protect you against 
theft, hardware failure, user error, and other catastrophes. This 
book helps you design a sensible backup strategy, choose and 
configure the best backup hardware and software for your needs, 
and understand how to make your backups as painless as possible. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to 
buy a new copy to read it more carefully or to keep it for reference. 
Discounted classroom and Mac user group copies are also available. 

Copyright © 2011, Joe Kissell. All rights reserved.
 

Updates
 

You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end; it’s available only to purchasers). On 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
any subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 
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Basics
 

Here are a few “rules of the road” that will help you read this book:
 

•	 Menus: Where I describe choosing a command from a menu in 
the menu bar, I use an abbreviated description. For example, the 
abbreviated description for the menu command that creates a new 
folder in the Finder is “File > New Folder.” 

•	 Contextual menus: Contextual menus appear when you Control-
click various elements on a Macintosh screen, including Dock items 
and files in Finder windows. To describe opening a contextual 
menu, I usually I tell you to right-click (Control-click) an item on 
the screen. If your mouse offers a right-click option, or if you use a 
trackpad or other means of opening a contextual menu, you should 
feel free to use the method you prefer. 

•	 Finding System Preferences: I sometimes refer to settings in 
System Preferences that you may want to adjust. To open System 
Preferences, click its icon in the Dock or choose Apple  > System 
Preferences. When the System Preferences window opens, click the 
icon of the pane whose settings you want to adjust. I refer to these 
panes using a brief notation such as “the Network preference pane.” 

•	 Finding an application’s preferences: I often refer to 
preferences in an application that you may want to adjust. Don’t 
confuse an application’s preferences with the system-wide settings 
found in System Preferences. To access an application’s preferences, 
choose Application Name > Preferences. For example, in the 
program Retrospect, you would choose Retrospect > Preferences. 

•	 Path syntax: This book occasionally uses a path to show the 
location of a file or folder in your file system. For example, Mac 
OS X stores most utilities, such as Terminal, in the Utilities folder. 
The path to Terminal is: /Applications/Utilities/Terminal. 

The slash at the start of the path tells you to begin at the top level of 
the disk. Some paths begin with ~ (tilde), which is a shortcut for the 
current user’s home directory. For example, if the person currently 
logged in has the user name joe and wants to install fonts that only 
he can access, he would put them in ~/Library/Fonts, which is just 
another way of writing /Users/joe/Library/Fonts. 
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•	 Big cats: I frequently mention details specific to a particular 
version of Mac OS X, which Apple usually refers to by a “big cat” 
code name: 

‣	 Lion: Mac OS X 10.7 

‣	 Snow Leopard: Mac OS X 10.6 

‣	 Leopard: Mac OS X 10.5 

What’s New in This Book
 

As I explain just ahead in the Introduction, this book is effectively 
the sixth edition of Take Control of Mac OS X Backups plus the 
second edition of Take Control of Easy Mac Backups, rolled into 
one! Although the title has changed and the information has 
been consolidated, this book relies heavily on the contents of its 
predecessors. So if you had either of those titles previously, here are 
the most significant changes I made that you should be aware of: 

•	 Totally rethought the organization of the material; even when the 
text itself is the same as in one of the previous books, it’s likely in 
a different place 

•	 Updated the information in What’s New in the World of Backups 
to reflect changes in Lion and many other recent developments 

•	 Included Factors to Reevaluate to help readers of previous Take 
Control ebooks about making backups quickly reassess their 
strategy as they begin reading this ebook. 

•	 Added Lion-specific information throughout the book, especially in 
Lion Is Out of Its Cage, Local Snapshots in Lion, Encrypt Your Time 
Machine Backup, and Auto Save and Versions in Lion 

•	 Included information about Thunderbolt in several places, 
including Choose an Interface (or Several) 

•	 Updated the information in Create a Duplicate with Carbon Copy 
Cloner to cover its new (and significantly changed) interface 

•	 Removed most of the discussion of backing up to optical discs, 
because with each passing year it makes less sense, and I want 
to encourage readers who are still stuck on this outmoded 
technology to walk toward the light 
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Finding the Online Appendixes
 

Some content that was previously in appendixes has been moved to the 
Web at http://www.takecontrolbooks.com/resources/0014/: 

•	 Joe’s Guide to Mac Backup Software: This former appendix is 
now hugely expanded, and it compares nearly 100 different backup 
applications. It was moved online to make it easier to update. 

•	 Retrospect Primer: This appendix provides procedures for 
setting up duplicates and versioned backups in Retrospect Desktop 
6.x, along with a brief look at the terminology, logic, and interface 
used in that version. (I discuss the newest version of the program, 
which thankfully doesn’t require so much handholding, in 
Retrospect.) 
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Introduction
 
The first edition of Take Control of Mac OS X Backups hit the virtual 
shelves in December 2004. I had no inkling at the time that it would 
go through five editions, eventually becoming the best-selling Take 
Control book ever. All I knew was that backups were a big problem 
for Mac users. Even though most people realized the importance 
of backups, few people could say with certainty that their data was 
completely safe in the event of any conceivable disaster. That’s because 
in 2004, properly backing up a Mac was, for the average user, a 
complicated, daunting, and expensive prospect. I wrote my book to 
help people sort through all those complications and eliminate the 
pain associated with backups. 

Over the years, things changed. Backup hardware, software, and 
services multiplied at a shocking rate, prices fell precipitously, and 
Apple made numerous changes to Mac OS X (as well as to Mac 
hardware itself) that would significantly alter the backup landscape— 
so I kept updating my book to cover the new stuff. By the time the 
second edition appeared in 2007, Take Control of Mac OS X Backups 
had nearly doubled in length, and had become so unwieldy for some 
readers that we decided to spin off a more concise, simplified version 
of the book—first titled Take Control of Easy Backups in Leopard, 
and later renamed to Take Control of Easy Mac Backups—as well 
as to move some of the book’s content into online appendixes. But the 
backup world kept right on changing, and both books kept growing. 

As I began working on what would have been the sixth edition of 
Take Control of Mac OS X Backups, I felt perturbed that my books 
had become so much more complex, even though backups themselves 
had become much easier! Part of the reason for this mismatch was that 
I’d never bothered to purge a lot of information that was no longer 
relevant. (Do I really need to browbeat you into scheduling backups 
to run automatically, or spend seven pages convincing you that optical 
discs aren’t the best choice for backups?) Another reason was that I 
was still trying to cater to those using what I now regard as an 
inefficient, old-fashioned approach to backups—the method I settled 
on back in the days when Retrospect was still the best choice in backup 
software for most Mac users. 
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I also realized that the basic three-pronged approach I outlined 
in Easy Mac Backups is, in fact, what I recommend for just about 
everyone, and if I obscure that information in the process of covering 
backups comprehensively, I’m doing my readers a disservice. 

So, clearly the time had come to rethink my approach, and in the book 
you’re now reading, here’s what I’ve done: 

•	 Merged the contents of Easy Mac Backups and Mac OS X Backups 
back into a single title 

•	 Thoroughly reorganized the structure so that all the basic 
information comes first, and the more advanced information (which 
won’t apply to everyone) comes later 

•	 Ditched (or at least condensed) material that no longer needs so 
many words to cover adequately 

•	 Changed the title to Take Control of Backing Up Your Mac, which 
I think is simpler and clearer 

Historical note: Part of the reason for the original title was that 
we wanted to be sure readers understood the book was only about 
Mac OS X, and didn’t discuss backing up Mac OS 9! 

•	 Updated the contents to cover Mac OS X 10.7 Lion, as well as the 
latest options in hardware, software, and online services 

With those changes made, I’d like to think that what we now have is 
a modern approach to Mac backups that covers the bases but doesn’t 
overwhelm you with extraneous details. I explain how to develop a 
solid backup strategy, what your choices are, how to set everything up, 
what sorts of pitfalls you may encounter, and how to restore your data 
if disaster strikes. Rather than explore every alternative exhaustively, 
I guide you gently but firmly into a fairly narrow set of options that 
should yield excellent results for the vast majority of Mac users. 

Before we get started, however, I need to mention a few qualifications: 

•	 This book is primarily for people who need to back up either a single 
Mac or a small network—not for system administrators who need to 
back up dozens or hundreds of machines. As a result, I say little 
about the high-end equipment and enterprise-grade software used 
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for backing up large networks, focusing instead on simpler products 
that you can purchase at a modest price. 

•	 I do not cover command-line software such as cp or rsync. My 
goal is to make the process as simple as possible—ideally, without 
requiring you to open Terminal or know anything about Unix. So 
this book concerns itself solely with software that uses a graphical 
user interface (GUI). 

•	 Although I provide basic instructions for performing backups with 
several popular programs, I can’t give you foolproof, step-by-step 
instructions for setting up every backup program you might use. 
But by the end of this book, you should have enough information 
to determine, with the help of your software’s documentation, the 
preferences and settings you need in order to achieve your desired 
outcome. 

This book covers backing up Macs running Mac OS X 10.5 Leopard 
or later, including 10.7 Lion. Although much of this material applies 
generally to machines running older versions of Mac OS X, I don’t 
spell out any differences. In addition, although I don’t cover Windows 
extensively, do see Windows Files and Volumes, which discusses 
backing up Windows when it’s running on your Intel-based Mac. 
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Mac Backups Quick Start
 
You can read this book in any order, but I suggest starting with 
Plan a Backup Strategy in order to understand the rationale behind 
the hardware, software, and setup advice I give later. Here are the 
components of a solid Mac OS X backup plan. 

Decide on a backup strategy: 
•	 If you already have a backup system in place based on what you 

read in an earlier edition of this book (or one of its predecessors), 
begin by reading Reassess Your Backup Strategy to find out what’s 
new and which Factors to Reevaluate to determine whether any 
changes are in order. 

•	 Everyone else: Start at the beginning, with the Plan a Backup 
Strategy chapter. You’ll soon Understand Joe’s Basic Backup 
Strategy, which revolves around three key components: versioned 
backups (containing multiple copies of files as they existed at 
various points in time), a bootable duplicate (a complete, bootable 
copy of your hard disk), and offsite storage (in case something 
wipes out your Mac and the backup media sitting right next to it). 

Assemble the components: 
•	 Figure out whether Time Machine is a good option for your needs, 

and if not, select a different program to perform versioned backups. 
Read Choose a Versioned Backup Program for a feature overview, 
and then either pick an option noted in Explore Backup Software 
Features or consult the online appendixes for details and sources 
(http://www.takecontrolbooks.com/resources/0014/). 

•	 Pick a Hard Drive or two to store your backups on (one of which 
may be inside a Time Capsule or similar device). 

•	 Learn how to Prepare Your Hard Drive with the right number and 
type of partitions and volume formats for the types of backups you 
want to do. 

Set up your backups: 
•	 If you’ve chosen to use Time Machine for versioned backups, read 

Configure and Use Time Machine. Otherwise, see Use Other 
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Versioned Backup Software to learn how to configure a versioned 
backup and verify that you can retrieve stored files. 

•	 Make a bootable copy of your hard disk, schedule it for regular 
updates, and test it to make sure it works with the advice in Create 
a Bootable Duplicate. 

•	 One way or another, Store an Extra Backup Offsite—either by 
physically moving backup media or by signing up for an online 
backup service. 

Address problems and unusual situations: 
•	 If your disk dies, your Mac is stolen, or an important file goes 

missing, don’t panic; read What to Do When Disaster Strikes. 

•	 After months or years of backing up your Mac, you may run out of 
space on your backup disks. Discover What to Do When Your Disks 
Fill Up. 

•	 Find out how to deal with backup needs that don’t fit neatly into 
the duplicate or versioned categories in Consider Special Backup 
Needs. As appropriate, read about Digital Photos, Dealing with 
Huge Volumes of Data, Version Control, Backing Up a Small 
Network, Backing Up While on the Road, and Windows Files and 
Volumes. 

•	 If a standard, run-of-the-mill hard drive doesn’t quite meet your 
backup needs, Consider Other Hardware Options such as a RAID, 
a Drobo device, or a hardware-encrypted drive. 
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Plan a Backup Strategy
 
In Take Control of Mac OS X Backups—especially in the earlier 
editions—I went out of my way to emphasize that there are 
many ways to back up one’s Mac, and my personal preferences 
notwithstanding, I attempted to lay out all the options, explain 
their pros and cons, and let you come to your own decisions about 
what method(s) to use. At first, this seemed like a reasonable, fair-
minded approach, especially considering that the options I liked 
best were neither the least expensive nor the easiest to set up. I 
wanted to offer an out for people who couldn’t stomach that cost 
and complexity, as well as explaining how the truly paranoid (and 
those with lots of cash to burn) could be extra, extra safe. 

But after seven years of reflection and a ton of feedback from 
readers, I’ve realized that providing an endless menu of options 
isn’t helpful for most people. In keeping with the Take Control 
spirit, I’ve decided to focus on the strategy, hardware, and software 
I can most heartily recommend based on extensive personal and 
professional experience. I’m going to give you my expert advice, 
and although that will include areas in which you can choose among 
several options, in this book I’m framing the decision more simply. 
I’ll be telling you, “Today’s choices are lasagna, fried rice, and 
ratatouille (and by the way, my lasagna is pretty darn good)” instead 
of saying, “Choose anything from The Joy of Cooking.” 

If you follow my suggestions, you can rest easy knowing that your 
data is safe—and you won’t spend a fortune or spend days fiddling 
with setup either. And if you opt out of any of the three main 
components I recommend in my basic backup strategy, you’ll do 
so with both eyes open. 

Understand Joe’s Basic Backup Strategy 

Basically, the strategy I want you to follow consists of three key parts: 

•	 Versioned backups: Use Time Machine or another backup 
program to store versioned backups—copies of each file as it existed 
at many points in time—on one partition of an external hard disk. 
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Reassess Your 
Backup Strategy 
If you’re reading this book for the first time, you may not already 
have a backup strategy—in which case, feel free to skip this chapter 
for now. But I suggest returning to it in a year or so, by which time 
you may benefit from its recommendations. If you already have a 
backup strategy, though, read on to learn the best way to proceed. 

As things change in the world of backups—new hardware, software, 
and services appear, old products are discontinued, data storage 
needs grow, prices drop, Apple updates Mac OS X and produces 
new Macs—I keep a running list of things to cover when the time 
comes to update my Backups book. Once my list gets to a full page 
or so, I know it’s time to start revising the book. Much to my 
surprise, that’s happened almost once a year on average since Take 
Control of Mac OS X Backups first appeared in 2004! 

I don’t undertake these updates lightly. I step back and think 
carefully about my recommendations in light of the way my setup, 
my backup needs, and the overall computing landscape have 
evolved. Is the advice I gave last year still valid? Should I temper 
my enthusiasm for a certain product, or lobby more forcefully for 
a particular approach? Is there anything about which I’ve changed 
my mind, or my own practices? 

Just as I reevaluate my stance every so often, you too should 
periodically reassess your backup strategy in light of new 
information. If you read an earlier incarnation of one of my books 
and set up your backup system based on what I said a year or more 
ago, I’d like you to reassess your strategy right now. Either way, put 
a reminder on your calendar for one year from now to come back 
and (re-)read this section, and then do it again! 

I want to begin with a brief “state of the union” look at what has 
changed in the last year or so (as I write this in late 2011), and then 
say a few words about Factors to Reevaluate as you reconsider your 
backup strategy, both now and every year. Feel free to skim this 
section to see which topics are applicable to you; you might want 
to jot down a few notes about those topics to help you identify items 
to concentrate on as you reformulate your backup approach. 
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Choose a Versioned 
Backup Program 
Under Leopard and later, Time Machine is the easiest way, by 
far, to create versioned backups—and it’s what I recommend for 
most people. However, you may not be most people. So I want 
to tell you a bit about why I like Time Machine, but before getting 
into the details about setting up and using it (see Configure and Use 
Time Machine), I also look at a few situations in which it may be 
the wrong solution. For those people who need different software, 
I point you in the right direction with a discussion of features to 
look for and examples of other versioned backup programs I can 
recommend. 

Decide If Time Machine Is Right for You
 

By now, I assume most Mac users are aware of Time Machine, the 
backup software Apple built into Mac OS X starting with 10.5 Leopard 
in October 2007. Apple’s goal was to make backups as easy as possible, 
and compared to anything that came before it, Time Machine is 
certainly much simpler to set up and use. In some cases, you can set it 
up and turn it on with a grand total of one click! It’s hard to beat that. 

Without a doubt, Apple got a lot of things right about Time Machine. 
And, with each successive update to Mac OS X, it’s become even better 
and more useful. For one thing, Time Machine is considerably faster 
and more reliable under 10.6 Snow Leopard and later than under 
10.5 Leopard. You can now migrate data from a Time Machine backup 
when installing a new version of Mac OS X, restore an entire disk from 
Time Machine using the Recovery mode in 10.7 Lion, and archive 
backups from a Time Capsule to an external drive. In Lion, Time 
Machine backups can also—finally!—be encrypted! And Apple even 
borrowed the slick Time Machine interface for browsing multiple file 
versions in Lion (see Auto Save and Versions in Lion, later). 

Time Machine’s elegant simplicity comes at a cost, though—the 
software lacks some extremely useful features found in certain other 
backup programs, and isn’t a good match for every user or situation. 
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Pick a Hard Drive
 
You’re going to need one or more external hard drives for your 
backups. (Even if you use a Time Capsule, you’ll need a separate 
external hard drive to store a bootable duplicate; see Decide 
Whether to Buy a Time Capsule for details.) You can find hard 
drives with every imaginable combination of capacity, speed, 
interface, and case design—and the selection changes constantly. 

In this chapter, I focus on the most important things to consider 
when choosing a drive (capacity, interface, and price) and help 
you to cut through some of the confusion. After you Decide Whether 
to Buy a Time Capsule, at the end of the chapter, I help you Decide 
How Many Drives to Buy and Find a Good Deal on Hard Drives. 

In this chapter I cover only ordinary external hard drives, plus 
the Time Capsule and a few similar devices. But you may want 
something fancier, such as a RAID or a Drobo; something simpler, 
such as an adapter to connect a bare SATA drive to a USB port; or 
something highly specific, such as a hardware-encrypted drive. I 
discuss such options later, in Consider Other Hardware Options. 

Decide on Capacity
 

The most important consideration in a backup drive, by far, is its 
capacity—how many gigabytes of data it will hold. In general, the 
bigger, the better. In fact, I could simply say to get the largest hard 
drive you can afford, and that would be a reasonable rule of thumb. 

However, if you can’t afford an especially large drive, or if the amount 
of data you have to back up is exceptionally large, you may want more 
guidance. So figure out the size you’ll need for duplicates, then the size 
you’ll need for versioned backups, and finally the total size to look for. 

Duplicate Size 
You’ll store, on part of your external hard drive, an exact, bootable 
copy of your Mac’s regular startup volume. (If you use a Time Capsule, 
which can’t store bootable duplicates, you’ll use an entirely separate 
drive for this purpose.) But the volume that stores your duplicate 
need only be as large as the amount of data on your startup volume, 
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Prepare Your Hard Drive
 
You’ve just unpacked your brand new hard drive (or two), and 
you’re ready to get busy backing up. You might be able to plug 
in the drive and start working with it immediately, but it depends. 
Some hard drives come formatted for Windows computers, for 
example, while others might be formatted for a Mac—or not at all. 
Some come preloaded with utilities and demo software. Some could 
use the wrong partition map scheme for your computer, which 
might, among other things, prevent Time Machine from being able 
to see or use the drive. 

In short, because each manufacturer has slightly different ideas 
about how you might want to use your drive, you should take a few 
minutes, before you do anything else, to make sure it’s configured 
correctly for your needs. 

Outta time: If you have a Time Capsule, its built-in drive comes 
preconfigured just the way you need it, so you don’t need to worry 
about anything in this chapter for your Time Capsule. However, 
you must still follow these steps for the external drive you use to 
store your bootable duplicate, and any external drive(s) you decide 
to attach to your Time Capsule. 

Choose a Partition Map Scheme
 

Your hard drive contains a tiny block of information called a partition 
map or partition table that describes things like how many volumes 
the drive has, how large they are, and where they’re located. The way 
information is stored in this little block of data is called the partition 
map scheme, and the choice of scheme turns out to be crucial to how 
the drive can be used. Windows PCs generally use a scheme called the 
Master Boot Record (MBR) Partition Table; pre-Intel Macs have, since 
the very beginning, used a scheme called Apple Partition Map (APM); 
and Intel-based Macs by default use a newer and more advanced 
scheme, GUID Partition Table (GPT). The partition map scheme 
affects the entire drive, regardless of how many partitions it has or how 
those partitions are formatted. 
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Configure and Use 
Time Machine 
If you’ve decided to use Time Machine for versioned backups, this 
chapter tells you everything you need to know about using it. (If 
you’ve chosen other software for versioned backups, skip directly 
to Use Other Versioned Backup Software.) 

Apple says it takes just one click to set up Time Machine; while 
that may be true in rare cases, it’s usually a bit more involved. 
This chapter walks you through all the details of setting up Time 
Machine, backing up and restoring files, and other activities. 

Time Machine has three visible components: a preference pane found 
in System Preferences (Figure 7); an application found in the 
Applications folder, Launchpad, or the Dock (Figure 8); and a Time 
Machine menu in the main menu bar. (You can enable or disable 
this menu with the Show Time Machine Status in Menu Bar checkbox 
in the Time Machine preference pane.) 

Figure 7: Specify backup drives and ignored volumes in the Time 
Machine preference pane. 
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Use Other Versioned 
Backup Software 
If you have decided to create versioned backups using a program 
other than Time Machine, set that up now. I wish I could give you 
step-by-step instructions for using each one of those applications, 
but that would take too many pages (and you can read the 
applications’ documentation for help). Instead, I want to give you 
a few tips for each of several good choices. Although I’ve used and 
can recommend each of the programs I mention here, I don’t 
pretend that this is an exhaustive list. There are many other 
excellent options, too, and you can read about them in the online 
appendixes at http://www.takecontrolbooks.com/resources/0014/. 

ChronoSync Tips
 

If you’ve selected ChronoSync for versioned backups, please be aware 
of the following: 

•	 Put synchronizers in containers: ChronoSync is designed 
around the concept of documents called synchronizers, which 
contain all the instructions for backing up or synchronizing a single 
volume or folder. 

When you set up a backup or sync operation, what you’re really 
doing is creating a synchronizer; the program prompts you to save 
it (in order to repeat that backup or sync procedure later) when you 
close the window or quit the program. Although ChronoSync gives 
you a wealth of options for each synchronizer, one fundamental 
limitation is that a synchronizer can apply only to a single volume 
or folder (and everything inside it). If you want to back up items 
from more than one location (perhaps even with different options) 
in a single operation, create one synchronizer for each folder or 
volume, save them individually, and then choose File > New > 
Container and add each synchronizer to the list. You can then run 
all the synchronizers in one pass, and even schedule the entire 
container to run at a predetermined time. 
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Create a 
Bootable Duplicate
Along with versioned backups, bootable duplicates are a key pillar 
of a complete backup plan. They let you get back to work quickly in 
the event of a hard drive failure, give you a useful troubleshooting 
tool, and make upgrading to a new version of Mac OS X safer.

You can’t make a bootable duplicate by copying files in the Finder; 
you need a special utility. Lots of programs can do this, but I want 
to focus on two—SuperDuper and Carbon Copy Cloner—that focus 
on just this one task but do it easily and effectively.

Warning! Remember, you cannot store duplicates of two drives on 
the same volume, even if you put them in separate folders—the result 
will not be bootable. Oh, and let me reiterate yet again: you cannot 
create a bootable duplicate onto a Time Capsule (or even an external 
drive connected to a Time Capsule) over a network.

SuperDuper and Carbon Copy Cloner can make one-off duplicates, 
but they can also be configured to run automatically on a schedule, 
updating the duplicate with just those files that are new or changed 
since the last run, and deleting files on the destination that are no 
longer on the source disk. I recommend updating your duplicate at 
least once a week, plus right before you install any Mac OS X update. 
Scheduling your duplicate to update itself overnight, every 24 hours, 
will give you that much more security—and the nightly backups will 
go quicker, too, since there will be less new data to copy.

Set Ownership on the Destination Volume

Check to see that the destination volume does not ignore ownership; 
if it does, your duplicate will not be bootable. To check this, select the 
destination volume’s icon in the Finder and choose File > Get Info. 
In the Sharing & Permissions (in Lion) or Ownership & Permissions 
(in Snow Leopard and earlier) portion of the window, make sure the 
checkbox labeled Ignore Ownership On This Volume is deselected.
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Store an 
Extra Backup Offsite 
No matter how many backups you have or how often you update 
them, they do you no good if they disappear along with your 
computer—as they likely will in the case of theft, fire, or any other 
serious disaster. I urge everyone to take the precautionary step 
of keeping a second copy of their backups safely away from their 
computer—preferably in another building altogether. You can do 
this with a second hard drive, with an Internet backup service, or 
with either of two services that let you use Time Machine remotely. 

Use an Extra Hard Drive
 

If you purchase two or more hard drives, you can set each of them 
up the same way; then, back up to one drive for a week, switch to the 
other one, and take the first offsite. Repeat this rotation every week 
or so, and you’ll be safe in the knowledge that if you lose your first 
backup, a second one is still available that’s no more than a week out 
of date. 

Although you can use this process with just two drives, having three 
is more convenient (although, of course, more expensive). At any time, 
you’ll have one drive (A) in use, your next-most-recent one (B) onsite, 
and your oldest one (C) offsite. When you rotate the drives, you bring 
your oldest one (C) back onsite and make it active, while taking what 
has now become the oldest drive (B) offsite—and so on. 

The safest way to keep multiple backup drives is to set them up 
separately. Configure one drive with partitions for duplicate and 
versioned backups. Set up Time Machine (or another archiving 
program) and let it run; also create a bootable duplicate. Then 
disconnect the drive and repeat the entire procedure with a second 
drive. If you use Time Machine, when you switch between drives, you 
need to tell it which disk to use now; see Use Multiple Backup Disks 
with a Single Mac. 
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What to Do When 
Disaster Strikes 
You’ve diligently performed the backups recommended in this 
book, and then, one fateful day, disaster strikes. It might be a small 
disaster (one important file is missing) or a large one (your whole 
computer is missing). In any case, the very first thing you should 
do is take a deep breath and remind yourself that everything is 
going to be fine. Once you’re finished not panicking, proceed with 
the instructions here, depending on the nature of your disaster. 

Restore Individual Files
 

The easiest problem to recover from is a small number of files that are 
missing, or for which you need an older version. Follow these steps: 

1. If you backed up the files using Time Machine, try restoring them 
following the instructions in Restore Data with Time Machine. 

Or, if you used another versioned backup program, follow the 
developer’s instructions (check the Help menu) for restoring your 
files. 

2. If the files are missing from your backup, check your bootable 
duplicate. Connect the drive (if it’s not already attached) and 
navigate to the location on the disk where the file should be. 
If it’s there, copy it to your main disk. 

3. If Steps 1 and 2 don’t work—for example if your entire backup 
drive is missing—move on to your secondary backup. That may 
mean fetching an extra backup drive from another location and 
following Steps 1 and 2 again, or using your Internet backup 
program to find the file in your online backup. 

Tip: If you need an older version of a file created in a Versions-
compatible app under Lion, you can retrieve it even more easily; 
see Auto Save and Versions in Lion for details. 
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Consider Special 
Backup Needs 
Although duplicates, versioned backups, and offsite storage cover 
most situations the typical user will encounter, some people have 
special backup needs that don’t quite fit the mold. 

I’m thinking, for example, of users with vast numbers of digital 
photos and those who are Dealing with Huge Volumes of Data 
because they work extensively with the gigantic files required for 
digital video or pro audio applications. 

Other special needs may include using Version Control software 
(including Versions, built into Lion) to save copies of your files 
more frequently than versioned backups would permit, Backing 
Up a Small Network, Backing Up While on the Road (especially 
photos), and backing up Windows Files and Volumes on Intel-based 
Macs. 

Each of these situations may require additional steps beyond 
conventional duplicates and versioned backups. 

Digital Photos
 

It used to be that photos were printed on paper, and people often 
kept negatives as well, which could be used to create new photos if 
the paper copies were lost or damaged. But now that most photos are 
digital, your memories—a new baby, a wedding, a dream vacation— 
are as fragile as the media on which they’re stored. 

Most of us have at least a few digital photos on our computers. But 
some people take pictures constantly, and feel justifiably concerned 
about entrusting this irreplaceable data to their computers. Also, 
digital camera resolution is constantly on the rise—meaning the next 
new camera you buy is going to require more space for the same 
number of images as your previous one. Your mobile phone, iPod, or 
iPad probably has a camera too. As the number and size of your images 
increases, you may find that duplicates and versioned backups alone 
don’t entirely meet your backup needs. 
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Consider Other 
Hardware Options
Earlier (see Pick a Hard Drive) I explained that hard drives are the 
best destinations for your backups in almost every case. However, 
I also mentioned that in some situations, you might not want a 
plain, stand-alone external hard drive but something with more 
(or fewer!) bells and whistles. In this chapter, I offer an overview 
of other types of hardware you might consider:

✦ Alternative Hard Drive Options: From enclosures with extra 
features to connectors and adapters that let you attach drives 
to your Mac without any case at all, there are numerous choices.

✦ RAIDs and RAID-Like Tech: Hard drive arrays have benefits, but 
may not be as useful as their manufacturers want you to believe. 
(The Drobo, which I discuss, is a special—and better—case.)

✦ Network Storage Devices: Apart from Apple’s Time Capsule, 
many other devices offer network-accessible storage without a 
Mac or PC.

✦ Local Network Servers: If you do have a computer on your 
network that functions (or can function) as a server, that’s 
another place you might store your backups.

✦ Hardware You (Probably) Shouldn’t Consider and Why: Among 
the choices I can’t recommend for most people are optical media 
(CD and DVD), tape drives, and flash drives.

Alternative Hard Drive Options

For most people, the path of least resistance is to buy an ordinary hard 
drive that plugs into your Mac with a USB, FireWire, Thunderbolt, or 
eSATA cable. But you might be willing to pay extra for additional 
features, speed, or capacity; or you might prefer to pay less and buy 
components with which you can cobble together your own solution.
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About This Book
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. 

Ebook Extras
 

You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and—usually— 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

•	 Read postings to the ebook’s blog. These may include new 
information and tips, as well as links to author interviews. At the 
top of the blog, you can also see any update plans for the ebook. 

•	 Get a discount when you order a print copy of the ebook. 

About the Author
 

Joe Kissell is Senior Editor of TidBITS, a Web site and email 
newsletter about Apple and the Internet, and the author of numerous 
books about the Macintosh, including Take Control of Maintaining 
Your Mac. He is also a Senior Contributor to Macworld, was the 
winner of a 2009 Neal award for Best How-to Article, and has appeared 
on the MacTech 25 list since 2007. Joe has worked in the Mac software 
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industry since the early 1990s, including positions managing software 
development for Nisus Software and Kensington Technology Group. 

In his increasingly imaginary spare time, Joe likes to travel, cook, and 
practice t’ai chi. He lives in Paris with his wife, Morgen Jahnke, their 
son, Soren, and their cat, Zora. To contact Joe about this book, send 
him email at jwk@me.com and include Take Control of Backing Up 
Your Mac in the subject of your message so his spam filters won’t 
intercept it. 
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Shameless Plug
 

Although I write about computers as my day job, I have a great many 
other interests, which I write about on several Web sites, including 
Interesting Thing of the Day (http://itotd.com/) and my personal blog. 
You can find links to all my sites, a complete list of my publications, 
and more personal details about me at JoeKissell.com. Or follow me on 
Twitter (@joekissell). 
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All product names and services are used in an editorial fashion only, with no intention of 
infringement of the trademark. No such use, or the use of any trade name, is meant to 
convey endorsement or other affiliation with this title. 

This title is an independent publication and has not been authorized, sponsored, or 
otherwise approved by Apple Inc. Because of the nature of this title, it uses terms that are 
trademarks or registered trademarks of Apple Inc.; to view a complete list of the 
trademarks and of the registered trademarks of Apple Inc., you can visit http:// 
www.apple.com/legal/trademark/appletmlist.html. 
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Take Control of the Mac Command Line with Terminal (Joe Kissell): 
Learn the basics of the Unix command line that underlies Mac OS X, 
and get comfortable and confident when working in Terminal. 

Take Control of Troubleshooting Your Mac (Joe Kissell): Learn basic 
troubleshooting procedures and how to solve assorted common 
problems. 

Take Control of Upgrading to Lion (Joe Kissell): Find friendly advice 
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Take Control of Using Lion (Matt Neuburg): Learn to use 10.7 Lion 
effectively, whether you embrace all of Lion’s new features or strike a 
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Take Control of Your 802.11n AirPort Network (Glenn Fleishman): 
Make your AirPort network fly—get help with buying the best gear, set 
up, security, and more. 

Take Control of Your Paperless Office (Joe Kissell): With your Mac, 
scanner, and this ebook in hand, you’ll finally clear the chaos of an 
office overflowing with paper. 
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